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Harmony 3 FH T EEHLIEHI BT, EEAFEEILZE (Peripheral Library, LA T fiFR
PLIB) FIHLHLEHIFEER (motor control module)

PLIB /2XF MCU Jlidfiis (fillyn pwm i, ADC BibEE) RIS ZE, R PLB
FAFERAE MCU IO B A7 28 U5 M B2 0. PLIB HH Harmony 3 H8 7 S FiA

(Chip Support Package, PARTREFR CSP) A4:ff. PLIB fifF Harmony 3 AT ¥ 14
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AJ DL 2 e AT T B A e N TR s DRI AR S S FR L R A

K T 2R A7 U7 IR 42 VA E 22 41, PLIB I8 & K& MCU JE IR F B RE,
B PLIB I FH B #E (PLIB applications) , FIFEAN)FE B SCRS; B4 DAFE B P ok
HEHE MCU J i 1 at A0 1R AN PLIB AR FH v

L% I B E & Harmony 3 H144 4 motor_control 30136 B IR K&
FE L 4% 1) 487 2 R R O 35 B SRS A o 36 B F ML 1) 0 RR T 6 AN R R AL g F L (43
U1 ACIM, BLDC, PMSM ) , i FIAN[F B4 75 (lan v/F 4586, /S8 7 B,
Wisp e mEsl, AR , EREHNHAT RN ESE . A HEMN
MR & (IRE B MCLV2 B BBl MCHV3) , P o] UE 348 FH DL 1431
FESRIRAN HAL, DAPRE 4R By R B, s r= S R AR . FR L A e v () 1)
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4. MPLABICD 4 iR 2%

5. MPLABICD 4 B4 &t

BAF:

MPLAB X IDE: v5.45 B¥ 55 il A

MPLAB XC32 4 ¥ %% : v2.40 B T HT A

MPLAB Harmony 3 Launcher v3.6.0 B 5 57 i s
MPLAB Harmony 3 framework

csp v3.8.3

dev_packs v3.8.0

mhc v3.6.5

motor_control v3.6.0
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(—)  ®ER: csp 5 puB
SKit SIS IS FH 3P 1A B8 ) SCHE A& Harmony 3 (B ZLRRIE ;R ME S th CSP S Bin .
HIIRAE N -

Bse, HJER Harmony 3 Bit & %% (MPLAB Harmony 3 Configurator, LA fai#R
MHC) %} MCU J& AT AT o &

SRJG, CSP ARFELL | MHC Bt B 2E % PLIB; PLIB Hi.c S AL.h LR R, Hod sy
X MCU S i AR B 27 A7 2% 17 Il 2 11

iJe, HUPHERL B AR A PILB BRI O, SEELNS MCU A IR B 15
E.

PA BRI AR T

%—, PLIB F&ALIUHE R, SR MCU JE I B2 A7 25 (1 EL A DRIk,
ITIREERAR, PAFITEDN, AT S AR .

B, NMAHBAATTLLEREEA LB B, AR EHARZ R (FImIRshZE. 3t
MR55 2 AR EEE) TSI e e S A SR o JRAT TR X S TR A B
PLIB Application.

PLIB Application

Configuration PLIB || PLIB

<OoaoopPusnOnoon >
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(=) puB
CLRBUAH I PLIB JF A B F B A ) JE ZE T I

1. f#if MHC it B McU JE il

MHC N P SR 4L 5 2 R i A ST, B 5 3 DR SN T T AT AiC &
i CSP A% PLIB, B4 N1 SEAE MHC H%F MCU JE#EHL (peripheral) #H4T
fic &

T H4E— Harmony 3 LFEF1 MHC. Available Components 3% f& 7~ BT A A] 1t i%k
HAFRFIRPIRFIFR s 223 T CSP, B4 Peripherals 7332, taie Bl fit
e MCU JE I

Active Components Fr%5 7R BT A LB % F 24 MR 5113 - Project Graph FR%E &
TN T A% F A B

Projects | Files | Classes | Active Components | [ || StartPage x| ProjectGraph |
X CRnER 4 XICRERE4 = 5|
- ADC1
- CMSIS Pack
. . Paripheral Library
- Device Family Pack (DFP) MEMORY
-~ EVSYS EIC ADC1
EVSYS
NUMCTRL
~ SERCOM3
TCCO Peripheral Library Paripheral Library pErEiEEl eEny
c_rolo_sam_c21_mclv2 - D... r Available Components =l
+ SERCOM3
Peripherals Peripheral Library
& Tools

<UJO.2MHC L[ O >
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7E Available Components #7251 T Peripheral 4332, 1875 B2 1) & i A e 6 44 59
Project Graph A% . AH LA AR 1) 77 B B ik 2 U IRAE Project Graph Fr2&EH .

c_rolo_sam_c21_mclv2 - D... I Available Components ]

+|

m
B

eripherals
-AC

CAN
DAC
DSU

- FREQM
PM
~RSTC
RTC

- SDADC

- SERCOM
- SUPC
"TC

N = O TR SO e oSO = WO < N O == BN = WY
- g G Bl Bl e e B B B B

o
—
0
0

<O00300000 MCUDDOn >

rtPage = | Project Graph® ]
CmEmE e

& 5 |

Device Family Pack (DFF) CMSIS Pack

NVMCTREL
Peripheral Library

SERCOM3
Peripheral Library

TCCO ADCO
Peripheral Library ripheral Library

<0400 00OO0 MCUDDOO >

Peripheral Library
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T — A 7 ], {E Configuration Options A% Hh 4 iR 1% B i e )
FrE BRI HBNHFTR, @—#TmER,

Configuration Options® Help

(= [

E-alC]

-Enable Slave

-~Select Sample Length (cycles) 4
R Conversion Time is 1,.33333333333 ug wrte

-~ Select Reference VDDANA w

f-&utomatic Sequence Configuration

H-Channel Configuration
i Result Configuration

H-Window Mode Configuration

| S e N S e A e |

i-Sleep Mode Configuration
<goSsogouooood >

BeESERE, N AT ERAF MHC it BIR A

MHC = save state
2. PLB: X5

P R A RS FE 4 (MHC > Generate Code) Jii, CSP 2= T #il %k FH 1 J&
HHAFA R PLIB. RN FE A A HAAA — > PLIB .c SCHAT PLIB .h SCAF

1E Projects #r%5H, FEJT Source Files = config > (MHC ECE %K) > peripheral,
FaT LAE 2 PLIB .c XXM,



e\

MICROCHIP

Projects x[ﬁlg [Class-a Iﬁchve
-- Linker Files

[L} Source Files

[lj config

E}E mdv2_sam_c21_pim

..... @ exceptions.c

----- |E‘] initialization.c

----- |FE‘] interrupts.c

----- |FE‘] libc_syscalls.c

E} adc

. 13 plib_adeo.c

: - 3] plib_adcl.c

G- dock

-- divas

-- eic

-- EVSYS

-- Mvic

-- rvmctr]

-- port

-- SErcom

<0.6PLIB.cI >

7E Projects #3251, JEFF Header Files = config > (MHC B2 & & F5)
HrT AR F) PLIB .h ST

10
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Projects x| Files | Classes | Active Compon
[L} Header Files

[Lj config

E*E mdv2_sam_c21_pim

----- E‘] definitions.h

..... E‘] device_cache.h

=gy peripheral

E} adc

. I plib_adc0.h

; |E‘] plib_adc_common.h
- dock
-- divas
-- BiC
-- evsys
-- nvic
-- nivmctrl
-- port
HE -

< 1.7PLUB.h L] >

sififE— PLIB .h SCAFEL PLIB .c SCfF, Navigator br%s<x 41 Hh I a0 & 1 R 4.
XL 1 pR HCAT R ) AN, F R L )

L

c_rolo_sam_c... T Navigator xr Available Com... =]
----- @ ADCO_CallbackRegister(ADC_CALLBACK callbadk, uintptr_t contex
..... &) ADCO_ChannelSelect(ADC_POSINPUT positiveInput, ADC_NEGINF
----- @ ADCO_ComparisonWindowSet{uint16_t low_threshold, uint16_t hig
----- [5P ADCO_ConversionResultGet()

----- @ ADCO_ConversionSequencelsFinished()

----- @ ADCO_ConversionStart()

..... 5P ADCO_Disable()

----- 5P ADCO_Enable()

..... (2P ADCO_Initialize()

----- @ ADCO_WindowModeSet(ADC_WINMODE mode)

<pgg.gpuB oo >

3. PLIB #HEHNER

PLIB T EN{E B AL T CSP HBh ez, HEK4E2: .\csp\doc\

11
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CSP HEBh IR & HWER 7 W% 5 —%B47 Peripheral Libraries Help E[I 4 PLIB 35 Bi{E
Ho HPFIH T Harmony 3 Fi SR EIFTE MCU AT A BIABEELF PLB (5. X

%{% 4%\@?&3

{4 B 2 R TR ) PLIBL P A 5 R B 4

Contents ] Index | Search | Favortes |

= W Peripheral Library Overview
=1 ) Peripheral Libraries Help
[7] sAM C20/C21 Peripheral Libraries
[9) SAM D20/D21 Penpheral Libraries
2] SAM ET0/ST0/NT0/VT1 Peripheral Libranies
[2) SAM D51/ES1/E53/ES4 Peripheral Libraries
[?] PIC32MZ EF Penpheral Libraries
[ PIC32MZ DA Peripheral Libraries
[# SAM A5D2 Peripheral Libraries
[2] PIC32MK Peripheral Libraries
[3) PICI2MX 330/350/370/430/450/470 Peripheral Librar
(7] PIC32MX 1:0¢/2X%/5XX Peripheral Libraries
7] PIC32MIX 13042%X Peripheral Libranes
[#) PIC32MX 1:0/2XX XLP Penpheral Libranes
[2] SAM L21 Peripheral Libraries
[ SAM L22 Peripheral Libraries
[7] 5AM 960 Peripheral Libraries
= I Peripheral Libraries
m @ AC Peri pheral Library Help
@ @ AC Periph eral Library Help
7 @ AC Penpheral Library Help
2] Q ACC Peripheral Library Help
= [ ADC Peripheral Library Help
[@ inroduction

[3 Configuring the Library
R usng o L]

& Q Library Interface
- & i

e Arm e

Perpheral Library Overview > Perpheral Libraries Help > Peripheral Libraries > ADC
Peripheral Library Help > Using the Library

Microchip

Documentation

32-bit Chip ) Eeedback
Su Contents | Index | Home Previous | Up | Next Micr
Package Support

Using the Library

ADC converts the selected analog input on software or hardware
triggers. It provides both polling and callback methods to indicate the
end of conversion to read the converted data from the result registers.
® With polling, the application will need to continuously poll to
check if the conversion is completed.
& With callback, the registered callback function will be called once
the conversion is completed. This means the application do not
have to poll continuously.

Callback method

This example demonstrates how to start conversion and read the
converted data with callback.

Copy Coda

woid ADC EventHandler (ADC STATUS status, uintptr t
context)

{

* Read the ADC result */

ade _eount = ADCO ConversionResulcGect();

¥

<pgg.eepuB oo >

4, HLEPLIB 2. W H A HLEAE Mcu B

PLIB FT#R BLA AR L R 2, W DASCRF R IR B (R A L 55 DL P o 4] o S A B
DT/ R R AN N O N T TR [ 8 92 L (S =P s e e b 8= = o s
BAERZTRZ I, Fril PUB 82 LRI BERE AL T INERAE R K. EXFMEAL T, W

e B ELR Y ) IR R A A

XtiE, Harmony 3 $& 4t 1 a7 8. 5) F SR g SCRISEI B, #E BT PR st S
Xf AR R AE AR BV IF) o BAASRIRE, £ — Harmony 3 TLAREHS & A3 0 A A7 Ji 145
Peap A7 S O G5 ARSE Lo GRS ) i 44 B g -

L PR B_REGS

12
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F P R TSR SCAE A i N B IR B S8 R AR S A4 %, st T AR U in) e B 2 47
2, i, %FT SAMC21 [ ADCO, HFEEHIA

ADCO_REGS->

SR J5 MPLAB X IDE <= H3h# H BT A5 ADCO FFAF 2422, MR k%
I

W ADC_AVGCTRL uint8_t
[ ADC_CALIB uintl1f_t
[ ADC_CTRLA uints_t

[ ADC_CTRLE uints_t
[ ADC_CTRLC uint1f_t
[ ADC_DBGCTRL uints_t
= ANC EVICTRI. mintd +

<pgpaoctonoooogooon >

(=) LB MNHBFE
1. PLIB NABIFE: JE A 5644

PLIB AMEFRALE: %L, I NFTE MCU BB R At 22 /b —/> LB N BIFE
HH P 2%, IXEHIFEHALE csp XHFIed, T2H2T csp_apps_[device_name] 3L
fEderp, Hip, [device_name]$s MCU 4 FK .

FTHAE— csp_apps_[device_name] S {4FJeH 1) apps SCAFIE, HAFIH T 1% mMcu
F) & A b .

13
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<bobmipuBC oo oooooon >

IR — BB, Hoh &g 2 /b — i -

<pgo.azeuBoooooooood s>

FIHE—R AR, HpEE 20—/ MPLAB L8 (B X SCfF3) -

<[ [0.12PLB 0O ECMPLAB O L 0 0T >

XL MPLAB A2 LM &4 . B sam_c21n_xpro.X K/xiZ% LIEIiEIT T
SAMC21 Xplained Pro F & #% -

TREYE AL T sre SCHFJer s

14
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2. PLIB N HBIFEH BIE B

PLIB N I AR A WM AT T CSP #EBh RS 2, HER 2
csp_apps_[device_name]\docs\apps. XT4&E4 PLIB NGRS, 5 Bh{E S .

® GG
® [T aEEIA
o fiRtizAT. Wilik

WERH A, FTHE— PuB NHBIFE, B H e NFE TFE (Projects #5325 >1E
TR A PR A5 > Set as Main Project) ; JF4TJF MHC. iXFEm ] LLE BIHIFEK)
Harmony 3 FC B 15t XA RU, XtEEENSEEER.
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= LR

(—) 3%

HL AL A & Harmony 3 H144 4 motor_control HSC/:32 . BALIE dil A e oK
F L% i 5 R AT AH OGS B SO A R A AR AL I AR 4R & Harmony 3 BLE S
SR HIIERG . X EEHIFEENZ /T LE Microchip [ HENLERT6 (R EIHR
MCLV2 B H Bl MCHV3) 2 b

(=) LS N FIRE

TEVEREMNE, YL HIEFREHALE motor_control A, T fr T
mc_apps_[device_name] L {fJeH, HH, [device_name]$s MCU & FR. -
mc_apps_pic32mk 5 T FTA PIC32MK 234 B AL S BIRE o X e SO S 45 -

mc_apps_pic32mk: &7 PIC32MKMCF 1 PIC32MKMCM [RIFTA CEEHLIESD FIFE.
mc_apps_pic32cm_mc: A PIC32CMMC HIFTE FIFE.

mc_apps_sam_c2x: & SAMC21 B A Bl FE .

mc_apps_sam_d5x_e5x: & SAMES54 HIHTH FIFE.

mc_apps_sam_e7x_s7x_v7x: & SAME70 [T A fFlFE o

ATUVEH, EEANBIFESCHIeF, HA WA Mcu BIRE. T R—KiEd e
F] MCU, T CPU ZEMFNANBEAAIR], W] LS5 B MCU.

X AL IR, Hoar A .
D000 0000 MUOO, #i4:

1. acim_vhz_sam_c21

16
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XAt LI AR (VE) 28, SAMC21.

2. bldc_bc_hall_sam_c21

X ELTC R AL T HALL {55 B3R B, SAMC21.

3. pmsm_foc_encoder_pic32_mk

XK G IR A FE AL T IE AT i 15 - (AR S, PIC32MK.

4. pmsm_foc_encoder_position_sam_e54

XF KGRI UL T IEAZ i 15 5 ML B ], SAMESA4.

5. pmsm_foc_encoder_sam_e54

XK [F) 20 LI, T IR A S (5 (A A% ], SAMESA4.

6. pmsm_foc_encoder_sam_e70

X KB IR] A LS T IEAZ i 15 5 A A%, SAMET70.

7. pmsm_foc_pll_estimator_pic32_mk

XK AR 20 FE AL - AU A () e A% IR A8 A I /], PIC32MIK.
8. pmsm_foc_pll_estimator_sam_e54

X 7K [F) 25 B L - A B 24 (0 e AR SR AR A /], SAMES4.
9. pmsm_foc_pll_estimator_sam_e70

X 7K [F) 25 B L - A B 24 (0 e A% SR AR A /1], SAMET0.
10. pmsm_foc_rolo_1shunt

XK AR 20 R AL T B R TR AR AR LI &5 1) JE A% JEk P P BELRAE AR A il
SAMC21.

17
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11. pmsm_foc_rolo_fw_mtpa_sam_c21

Xt 7R TF) 25 FE LI - BB A1 4% LN 28 B4 To A Tk A Aidas i), R 30 53 4 o) R e
KREEH IR L], SAMC21.

12. pmsm_foc_rolo_sam_c21
X} 7 A R A F LI T B B e A A UL 25 1R T A% IS AR A= ], SAMC21.
13. pmsm_foc_rolo_wm_sam_c21

X 7K R 25 B3 1 B e A A WL 45 P oA s A A, L S NSUXUS Bh DI RE
SAMC21.

14. pmsm_foc_smo_sam_e70
Xof 7K B [ 25 FATL S T T RS 0 85 1 T A% IR AR %], SAME70.
15. pmsm_pfc_foc_pll_estimator_sam_e70

XK [F) 25 B AL - A B 3 (R T A% R AR AR I 1), A IR Zh 4 PR R MR IE
SAME70.

FIHAE— LSRR S, HpEHRDb— MPLAB L2 (B X X9

src
mclv2_sam_c21_pim.X
mchv3_sam_c21_pim.X
<gboatctodobooMPLAB O OO MO >

AV LV

X4 MPLAB LFE LM H"F &4 . Bl mclv2_sam_c21_pim.X F¥/n1Z LIEisiT T
IS ML I ENAR MCLV2 F1 SAMC21 motor control Plug In Module (PIM).

TREIE AL T sre ORI

18
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FTHAE—EBNIEHIGIRE, BHEE N T TR, FF4T7HF MHC. XFERL ] LUE 212
] Harmony 3 Bt & &, %0 ADC, PWM Fib, drss, XA ki, XtE=®E
BEWSEER,

(=) LB
FEALA Bl 35 B SRS 67 T 25 MR SR e, 48

4. . \mc_apps_sam_c2x\docs\apps\acim_vhz_sam_c21\
TR LA T S GRS, FEBSCOR & A LU WA

A 5

MHC Fic & /41
HLLE% il S5 A 28

FIT e B 51) 2 B L4 52 5 %
BIREEE . 817 A%

19
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IR FENLE I S BIRESE . 2T RER 048 LU 43 B o A%
TR AR 5E R 1]

(—) Wk
PLR DL AL FIFIFE pmsm_foc_rolo_sam_c21 N, FRZEHAFEFERTIH. LE
F LI BB FE ) D58, A] DA R RE R 7 1R 1298

(=) HUEE

IR 5 B SRS 7
T+ .\H3\mc_apps_sam_c2x\docs\apps\pmsm_foc_rolo_sam_c21\

LT A A A N AL R N R e T, R
® kN

B T AR R BR ARG B R 6

® MHC fic &

T P A MCU I R TC B A 0

® FEiHlEIE

Zi eI 0 Kl K RPN L P Y e L A DN B S P 7 B - W RPN 1 R W R 7N
AT
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<gUuaggouoood s>
ADC Interrupt
Main

10ms

Read input
switches

X2CScope tasks

Infinite Loop

elapsed?

Read phase current
ADC values

Scale Phase current to
02.14

Clark's & Park's
Transformation

Angle and Speed
Estimation
Interval

D & Q axis Current Pl
Control

rmation

SVPWM Calculation
and Update

Return
21

Field alignment time
exceeded ?

Has the motor reached
minimum speed?

Closed-loop Con
(RUNNING)
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<pgo20000M0 >

Macro Description Units
MAX_FRE_HZ Electrical Frequency at maximum motor speed Hz
MIN_FRE_HZ Electncal Frequency at minimum motor speed Hz
POLAR_COUPLES Number of Pole Pairs

R_STA Motor per phase resistance Ohm
L_SYN Motor per phase inductance H
Max_CUR_AMP Maximum motor current A
START_CUR_AMP Current reference dunng field alignment and open loop startup A
ACC_RPM_S Acceleration ramp rate RPM/s
DEC_RPM_S Deceleration ramp rate RPM/s
STUP_ACCTIME_S Open loop start up time H
CUR_RISE_T Current rise bime during field ahignment s

<gno3000goboooooooobpooog s

o fffifEit
FIH TGRS AT P fa i A B M, el TR k.

(Z) MHCEE
1. {¥i/] MPLAB X IDE 3T JF I F%

File > Open Project... 2> W% & TREFTERAE > EFF mclv2_sam_c21_pim.X L%
> Aiii “Open Project” %4l

TEN S pmsm_foc_rolo_sam_c21 41, > MPLAB T.f2:
mclv2_sam_c21_pim.X Al mchv3_sam_c21_pim.X. FATEFEEIT TARE BT AR
#) L2 mclv2_sam_c21_pim.X.

2. KRt NE TR (Main Project)

1E Projects /3% T bs £ F i TFE > set as Main Project
T LA A FRE U AR AR B .

3. {TJF MHC

22
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Tools 2 Embedded - MPLAB Harmony 3 configurator

MHC #1797 )5, W] LATE Project Graph #2822 LI A F . X658 40 FE L
ISR UL, FrA AR E MCU IO, BIFE mclv2_sam_c21_pim.X 2 Ul
. AT PLE BhZ AR 1 MCU JE A

ADCO, ADC1: TR %t e

TCCO: Ak PWM IRENE 5

EIC: AR 51 B FE~F A2 Bl b I 4
EVSYS: F PWM Fiffili ik ADC K A¥
DIVAS: FRIEFFR-S (PR ik 25
SERCOM3: X2CScope fIT 7 It £ i@ TH,

Default Component:
CMSIS Pack Device Family Pack (DFP)

NVMCTRL
Peripheral Library
MEMORY

Motor Control Peripheral:

DIVAS TCCO ADCO
Peripheral Library Peripheral Library Peripheral Library

EIC ADC1 EVSYS
Paripheral Library Peripheral Library Peripheral Library

X2C Communication:

SERCOM3
Peripheral Library
I2C

<0400 00O0 MCUDDOD >

A JTHER, ] LAfE Configuration Options Fr&& A BIHACEE L -

23
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Configuration Options™ Help [=]
= #
=-TCCO
- Select Prescaler Mo division w
- Select PWM Type Dual slope PWM with interrupt/event when
- Select Qutput Matrix Default Channel Qutputs
- Period Value 2,399 =

- FEEE DM Frequency is 10000 Hz ##+*
-Enahble Period Interrupt [
- Enahble Period Event Out

= Channel Configurations

E+Channel 0
%----Dut\; Walue 0=
- Output Polarity Waveform starts at low
%----Enable Dead Time
E"---Swap Qutputs O

-Enable Compare Match Interrupt [
‘~Enable Compare Match Event Out [
- Channel 1

B Channel 2

B Channel 3

- Dead Time

I SR B e T PR S S Ao

<pgo.sTCccon oo >

b

k% T Configuration Options A2 HH FIACIREC BLIE A, MHC J0XT— 285 FH i 4l 4
Peft T AN EITEAEC B S . 0

® ADC easy view

MHC - Tools = ADC configuration

24
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Software Trigger

Free Run

H
anzloglnput |
H

4nalog Input E
j

ADC Configuration 0

Channel B
Sequencer

Run in standby []

On demand control  []

Automatic Window Comparison

Prescaler

|Peripheral dock / 4

v]

Left-aligned rasult

Result Register

WINMON Intarrupt

EVENT

Result Interrupt

Rasult Event

® Clock Easy View

< [J .6 ADC Easy View >

MHC - Tools = Clock configuration

XOSCIK

Clock Source

\k)—%

GELK_DPLL

xosc

0sc
0scaaM oscsa
48,000,000 Hz FOPLL
oscus
0sc32K.
e %05C3K.
SCLK_INto]
seua
xosc
oscaem
FOPLL
oscuLPaK
oscaz
%0SC3K
aeLk 1)

< [J .7 Clock Easy View >

® Pin Diagram, Pin Table, Pin Settings

MHC - Tools = Pin configuration

K= S (1 D RE A

25

—HER, R BUEFAR AT — R3S 5| AT R E

GELK Gamaratar 0 Wiain Gock
@ U
48,000,000 Hz
= Cra—
48,000,000 Hz
[ R
— [P—
saa | |
: GOLKZ
s
SRLE B D sk IS mai‘:a'ia
souks S s
&
GOLKE _
sax
! - .
EIC
15 32,768 Hz
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ToddmrFroocFFUadcaddd

| N
® 4 63626160595857 565554535251 5049
paon @1 45 [ vDDIO
panl @z 47 [ GNDIO
panz [ 3 46 [0 Pazs
pans [ 4 45 [0 Pa24
FE04 [ 5 44 [ SERCOM3_PADL
PE0S [ 5 43 [ SERCOM3_PADD
GuDans [ 7 4z [ Pazi
voDana [ s 41 [ Pazo
pE0E [0 9 ATSAMCZ1J18A 40 [0 PEL7
PEO7F [ 10 39 [ BTM_START_STOP
ADCO_AINZ [0 11 33 [0 pats
ADCL_aINS [ 12 37 [ EIC_EXTINTZ
pand [ 13 36 0 Pa17
Tooowol [ 14 35 [ TCCO_wos
pane [ 15 34 [ vDDIO
pan? [ 16 33 0 GMDIO
1718192021 22 2324 2526 27 28 293031 32
i I I s o o e o o o W
SEDTEEZEESRRITREE
< [J [1.8 Pin Diagram >
Package: QFNG64 w :2[; . .CEI 'CEI §| cfl EI o | o D-| CS|
ERI=R =N = (= el - - = = = I =T = = = = - Rl
s 2|22 2|2|E|F|E|E|E|F|E|E|E|F| | 8|8
Module Function 7|8 |9 |w|11|12|13|14| 15|16 |17 | 18| 19| 20| 21|22 |23 |24 |25|26 |2
AC_CMP3
ADCO_AIND
ADCO_AIN1VREFP
ADCO_AIN10
ADCO_AIN11
ADCO_AINZ
ADCO_AIN3
ADCD
ADCO_AIN4
ADCO_AINS
ADCO_AING
ADCO_AINT
ADCO_AING
ADCO_AING
< [J [J.9Pin Table >
Order: | Pins ~ Table View Easy View
Fin PinID Custom Mame Function Mode Direction Latch Pull Up Pull Down
Mumber
PADD Available w Digital High Imped... ~ Low O [l
2 PAD1L Available ~ Digital High Imped... ~ Low O [l
3 PAD2 Available ~ Digital High Imped... ~ Low O I
4 PAD3 Available ~ Digital High Imped... ~ Low O O
5 PBO4 Available ~ Digital High Imped... Low O O
5 PBOS Available ~ Digital High Imped... Low O O
7 GMNOANA Digital High Tmped... Low O O
] VDDANA Digital High Tmped... Low O O
g PBOS Available v Digital High Imped... Low O O

< [0 [J.10 Pin Settings >
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® EVENT Easy View

MHC - Tools = Event System configuration

Channel Configuration -
9 Channel 1 Settings
Channel Event Generator Event  User Remove
Number Status  Ready  Channel Path Selection: ASYNCHRONOUS v
Channel 0 | TCCO_OVF ~ [ ] [ ] Remove _
pr——r 0 0 p— Event Edge Selection: RISIMG_EDGE v

Generic Clock On Demand: []

Run In Standby Sleep Mode: []

Add Channel

User Configuration

USER Channel Mumber Remove User
ADCO_START + | Channel 0 w Remove
TCCO_EV_0 + | Channel 1 w Remove

Add User

< [1 [1.11 EVENT Easy View >

G 0
1. YR

B RE BRI ST B BAS TN 8870 2R ks
® config Hx

i Harmony 3 #34l MHC HHC & 11 5 2042 s SO, #7E config H3¢H . PLIB I
AL T config H 3% T peripheral 1 H3& .

® main_mclv2_sam_c21_pim.c /¥

B 2 RSB e AL T o flhn: Ep s, ADC TR ST s 0 (AL
PERI R SEIAL T Z R Berh) L i IR P R 55 eR B
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® mc_app.c X

FATL% 1) bR A Tzt o AL i bR B0 B iR e s JE S AR R B0 - FR
WL 45 : motor_start(), motor_stop(), motorcontrol(),
pwm_modulation()%5 .

® Motor Control Library H ¢

FATL5 1 ZE VR SCE (q14_generic_mcLib.c) B 0 AR k& XN 25 2 Y S 4
(q14_rolo_mcLib.c) f7-F Motor Control Library H 3. X FEANE SO A 1 BRI AR
ST A ZER B )2, #_E iR motor_start(), motor_stop(), motorcontrol(),
pwm_modulation()&5 & E0H F -

® X2C Scope H¢

5 X2CScope I T # R, A2 T1% H 3% N B SC .
E}Eﬂ Source Files

Eﬂ---ﬁ config

----- E] main_mdv2_sam_c21_pim.c

P E] mc_app.c

Ej---ﬁ Motor Control Library
Ej---ﬁ X2C Scope
<0100 000000 >

2. k3
PAGIFR ) SK SO H DR FAN 3893 2 R
® config H¢

H Harmony 3 #3% MHC [I7C & 1 5 20 A2 s Sk SCfF,  #4E config H % . PLIB 3k
XAHAL T config H 3 T 1Y) peripheral ¥ H & H.

Ak, ok T S B B B ) Sk S0 userparams.h 47T config HaEd . XHEIAE L
TRE RN ECE (W S8, SR, EHEmeE) &2 E
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userparams.h A 7% 58 5T o X B85 58 I BARE S, FEZBIFE I3 B
R R A RN TR

® mc_app.h 34
LRI me_app.c SCH) Sk A,
® Motor Control Library H 3%

Motor Control Library Y5 A4Sk SCAEAL T1Z H k. Hb, q14_rolo_mcLib.h 3
A4 (R 43 7 7 SR AR B BT A1 A8 W0 s 1) 12 g

® packs H 3

T MCU BRI S Se A FiZ Bt . X B0 5 MCU BB 25 A7 28 1 58 SR
CMSIS FHFEE Yo X EE UKHT MCU B, (HANEE MHC Bt & 1484k .

® X2C Scope H3x
X2CScope Vi SCAF ISk UL T iZ H 3% H

E} [aﬁ Header Files
E . ﬁ config
N | mc_app.h

. E Motor Control Library
i-(iE packs
M- {5 2c scope

<D] 00000000 s>

() R
LT WSO P 3 St AT 2 BRI

BEANFEI A 4T SAMC21 PIM FRRS, 75 E4HE ] MPLAB ICD4 %5 FIl MPLAB
ICD4 ¥ 3EA4F: X2CScope [F 5 1IE N, 752 Ad FH RS232 %% USB 445 .
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cmoHIA Y

lugsr
3E5an
R

dsPICDEM™ N2
ST 1) Development Board =

LELELLL

<o ooogoooog s

s Ee )
% FAITOCS T
i 'y e

eazic CF Fr
R emanie Y
e
Dieazso S
PAZTO

Caw ‘3’\

CE &
R62 C39 ¢ —
s B " LART o
ity I 5 —
" B Ry L AR

:ﬂg\gm: o 6

o~

Y
J18 .J‘z l l I ] !l

<0Qpasico4 g RS232 0 UusB O oL >
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(X)) HwFE. RE. BIT5RER
1. wmiFS5EE
B, ¥ cpa s 5 EIER:; FH8 McLv2 fiEHE DC24v.

SRJ5, 1L Projects bp& b A st TFE44 - Properties > 73 H ) TRE @M 1
HH, 24 Hardware Tool N ICD 4; %% Compiler Toolchain i XC32; siiy “HfiN”
T R 1

]
( Categories: Configuration
e @ General Family: Device:
- ----- @ File Indusion/Exclusion All Families - ATSAMES4P20A -
=~ @ Conf: [mclv?_sam_e54 pim]
----- @ ICD4 Supported Debug Header: Supported Plugin Board:
----- @ Loading
----- @ Libraries ITE 1=
| @ Buildng Packs: Hardware Toal: Compiler Toolchain: I_I
L | =) © XC32 (Global Options) Packs Hardware Tools ~ Compiler Toolchains i
! o xc32as 5| | SAMES4_DFP §----oo Atmel-ICE -ARM
H e @ xc32-gec [ < ARM (v6.3. 1) [c:\Program Files (;
I @ xC32gH+ [2-%C32 [Download Latest]
e @ xc324d RSI: JIT 180811035 [ 8% C32 (v2.15) [C:\Program Files (4
& we3tar -0 PICKE4 | b @ XC32 (v2.10) [C:\Program Files {
@ PICKit3
- Real ICE
= | - Simulator E
il - Snap | 4
u = | Alternate Tools
£l -.00 EDBG
4 L-00 JTAGICES
00 mMEDBG
L@ PICKit2
0 PKOB nano
.00 Power Debuager N
£ > £ >

T T *Tip: double dick on serial number (SN) to use a friendly name (FM) instead.

Cancel Apply Unlock Help

)5, miii MPLAB X IDE %= ) R 8], Dl it 57 2 H #r MCU.
2. 1817
TEBIRETE Bk, XS AN R Sh e A VR4 Ui B

B, N S2 &4, HANLUFRIEE JRE4ED ; nLIWEES], LED 4T D10~ D15
g B8 PWM B SIEEHH .
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NG, TR A A, g LTI AL

B, FRHIHES 2 4%4H, Bl ks

TEHHUF IR, #% K S3 4%4H, LED %% D2 ris%, RoRHNLEL YIRS £
3. f# ] X2CScope ik

X2CScope ffiff %45 J71%, W 2% Harmony 3 HIALAZ 5 B SCRY
.\motor_control\doc\help_harmony_mc.pdf

B4, B RS232 ¥ USB £k 25 5 HINIESE, FF4TFF X2Cscope #if4: Tools =
Embedded - X2CScope

SR, 1E X2CScope Configuration b2 4T & -

1) s Select Project #%4H, fEH NRFIRA, LR H LI
2) BELHE RS232 IEINSH, W NEFIR;
3) A7 Disconnected %40, JEzh@EINIERE . EZRKRIE, WHERN:

connected.

Connection Setup  Project Setup  Data Views 5

Serial
Baudrate 115200 v
Data bits 8 e
Parity MNone v
Stop bits 1 v
Serial port  |COM22 w

< [11[1.16 X2CScope [1 [ [ [0 [T [ >
)5, 3 X2CScope AT IR .
1) #%EFF Data Views #5325, F 457 Open Scope View #2401, VAT HEKAER 25
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2) FERAF RS A T T RIEE SR T, R HEE > AR L,
A EMEN LR =Y. %R curdgm.y Fl elespeed, PARL%EE q FliHL
T LS A

3) st SAMPLE 4ZHIHfis ¥ iibl, MEBIE.

250 300 350 400 450 500 S50 €00 6S0 70O 7SO 8OO BSO 900 950 1,000 1,050
t[ms]

[— #1: cundam.y — #2: clespecd]

# Trigger Enable Visble Source Color Gain Offset
0| O | & | M |jardmy || 3 o
1| O 1 | [ |elespeed [ ] 0.2 0
20 O0|#& [ | : 0
s o0 H [ | : 0
<o 0™ [ ] : 0
s| 0 0™ [ | : 0
s 0 0O#& [ ] : 0
o0& [ | : 0

Tggerdge [Rng |

ey G [

e r——— ——r — T ——e—— — m—m——

<70 X2CScope L L OO0 OO OO0 >
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